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Creating, Saving Word Documents

Introduction
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§ 1.

1 Getting to Know the Clear Document Screen

A clear document screen of Word is shown below:

Title Bar
e Menu Bar

Standard Toolbar
Formatting Toolbar
Insertion Point

Up Scroll Triangle

FEE IR BT

Vertical Scroll Bar

Status Bar I-beam Pointer

Horizontal Scroll Bar

When Microsoft Word is open, a clear document screen displays. The features of the docu-

ment screen are described below:

Feature Description
Title Bar The document name displays at the left side of the Title bar followed by the program name such as Microsoft
word.
The menu bar contains a list of options to manage and customize documents. Word functions and features are
Menu Bar | grouped into menu options. For example, functions to save, close, or open a new document are contained in the
File option on the Menu bar.
The Standard toolbar contains buttons that are shortcuts for the most popular commands. For example, buttons
Standard E . . i :
Toolbar are available for opening and saving a document. Position the arrow pointer of button on the Standard toolbar
and, after one second, a ScreenTip displays with the name of the button.
Forma The Formatting toolbar contains buttons that can quickly apply formatting to text in a document such as bold,
Toolbar italics, and underlining. Position the arrow pointer on a button on the Formatting toolbar and, after one second, a

ScreenTip displays with the name of the button.
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(Continued)

Feature Description
Ruler Set margins, indents and tabs with the Ruler.
The Status bar displays information about the text in the document and whether certain working modes are active.
The Status bar also displays the current location of the insertion point by page number, section number, line
measurements, line count, and column position. At the right side of the Status bar, working modes are displayed.
‘When a working mode is dimmed, it is inactive. When a working mode is active, it displays in black.

Status Bar

§ 1.2 Displaying and Moving Toolbars

The Standard and Formatting toolbars display below the Menu bar at the top of the screen.
These toolbars may display side by side with only a portion of the buttons visible. To display the
hidden buttons, click the More Buttons button displays a palette of buttons.

Practice:

The Standard and Formatting toolbars share one row =y

1. At a clear document screen, Click Tools, expand the drop-down menu by clicking the
down-pointing arrow»s that display at the button of the menu, and then click Customize.

2. At the Customize dialog box, click the Options tab. (Skip this step if the Options tab is
already selected.)
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3. Click the Standard and Formatting toolbars share one row check box.
4. Click the Close button to close the dialog box.

To turn on or off the display of ithe Standard and Formatting toolbars
1. Position the mouse pointer anywhere on a toolbar, and then click the right mouse button.
2. At the drop-down menu that displays, click the toolbar name you want turned on or off.

Moving toolbars

1. Position the mouse pointer on the left of the toolbar, the pointer becomes $
2. Drag the pointer to the desire location.

§ 1.3 Saving and Naming a Document

When you have created a document, the information will need to be saved on your disk or
flash disk. A variety of methods can be used to save a document. You can save by clicking the
Save button on the Standard toolbar; by clicking File and then Save; or with the shortcut
command, Ctrl + S.

Document names created in Word and other suite applications can be up to 255 characters in
length, including the drive letter and any folder names, and may include spaces. File names

cannot include any of the following characters:
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forward slash (/) question mark (?)
backslash (\) quotation mark (“)
greater than sign (>) colon (:)

less than sign (<) semicolon (; )
asterisk (*) pipe symbol (])

§ 1.4 Saving a Document with Save As

The Save As option is used to save a previously created document with a new name. For ex-
ample, suppose your boss gives you a document named Market Funds, and he wants you to edit or
modify it. In order to remain the previous edition and make some changes to another edition, you
must use the Save As option. When you use the Save As option, Word displays the Save As dialog
box where you can key a new name for the document.

Practice:

1. Open Word Document 01.

2. Save the document with Save As and name it Word C1.

3. Make the following changes to the document:

a. Deletcv the word rare in the first sentence of the first paragraph.

b. Delete % in the second sentence of the second paragraph and then key percent.

c. Delete the word actually in the last sentence of the second paragraph.

d. Delete the word general in the last sentence of the second paragraph.

e. Change the word primary in the first sentence of the third paragraph to main.

f. Delete the words in this phase of the expansion in the second sentence of the third
paragraph.

g. Join the first and second paragraphs.

4. Save the document again with the same name.

5. Open Word Document 01 and Word C1 to check the differences.

6. Close Word C1.
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§ 1.5 Reading Material

Processor
Your processor is the brain of your computer. It is also referred to as the microprocessor or
CPU. It interprets all the instructions that it receives from various devices and then executes those
instructions, such as telling your printer to print. The faster the processor, generally the faster the
computer will usually be able to perform those instructions and tasks, thus games can play more

smoothly and spreadsheets can calculate more quickly.

About this time last year Intel launched what was the fastest 45nm quad core CPU on the
planet, the Intel Core 2 Quad QX9770. Well, guess what, Intel has done it again with the latest
architectural achievement, the Core i7 Extreme 965. What the two have is common is that they
both are based on Penryn cores, they both are 45 nanometer chips and they both run at a clock
speed of 3.2GHz. After these things what you have is a whole new animal. Gone from this chip is
the twelve megabytes of L2 cache, this is replaced by a third level of cache at 8MB. Slow and
inefficient it is not. With the addition of an integrated memory controller, the memory bandwidth
is expected to be huge by comparison to today’s top-.of the line processors, somewhere close to
two to three times the peak bandwidth. SMT(Simultaneous Multi Threading)has made a return on
the Core i7 generation. This will enable the processor to run a total of eight threads at one time.

The Intel, Core i7 Processors appears to be the quickest on the market today in comparison
to others. However, due to the rapid changes in technology on a daily basis, what happens to be
the fastest today isn’t necessarily the fastest tomorrow. The exceptional graphics, memory, and

processing capability from the Core i7 processors also make them in all probability just the right
- 6 -
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desktop computer systems for house use. It guarantees an exceptionally rapid digesting speed for

multitasking computer function.

AMD is Intel ’s main competitor, and their CPUs are usually cheaper with similar speeds.
They have been less popular because they had been found to be somewhat if not completely
unstable because of their motherboards that tended to go awry. In the past couple of years, their
reliability has become somewhat more significant, and most people believe that Intel and AMD
have the fastest paced processors available.

Finding an ideal processor for your computer or laptop is not a daunting task. You just need
to keep in mind some points that can further help you to make a proper decision regarding the
right processor. AMD is a popular brand when it comes to computer or laptop processors. The
AMD Athlon IT X4 Quad Core processor is not the best in AMD family however it is really
popular as it offers great amount of performance. Being a quad core CCPU, this device offers 4
times the punch and is even featured with great power to run any game or high end graphics. It
even has the flexible AM2+/AMS3 socket and is further compatible with different motherboards.
Packed with performance enhancing technologies, the processor will actually take your computing
experience to the zenith. For computer users, this simply means that they will be able to run the
latest possible software without any slowdown that they may generally experience with the
inferior processors.

The Intel Corporation produces multiple families of processors for desktop
computers, laptops and netbooks. Each family consists of many individual processor
models, each with their own features and performance capabilities. Clock speed,
cores and cache are main specifications of processor. Clock speed is only one aspect
that determines a processor’s overall performance. Another is the number of cores
included on the chip. The more cores, the more operations the processor can perform
simultaneously. Cache memory is also a factor, supplying data to the processor much
faster than RAM. For excample, Intel® Core™ i7 Extreme Processors included 4

cores. The speed is 3.0 GHz, and cache memory is 8.0 MB.
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The mouse and / or keyboard can be used to select a specific amount of text. Once you select

the text, you can delete or perform other Word functions involving the selected text. When text is

selected, it displays as white text on a black background.

§ 2.1 Selecting Text with the Mouse and /or the
Keyboard

You can use the mouse to select a word, line, sentence, paragraph, or the entire document.
The selection bar is the space at the left side of the document screen between the left edge of the
screen and the text. When the mouse pointer is positioned in the selection bar, the pointer turns

into an arrow pointing up and to the right. The figures of selecting with the mouse are below:

To select Complete these steps using the mouse
A word Double-click the word
A line of text . Click in the selection bar to the left of the line
Multiple lines of text Drag in the selection bar to the left of the lines
A sentence Hold down the Ctrl key, then click anywhere in the sentence
A paragraph Double-click in the selection bar next to the paragraph of triple-click anywhere in the paragraph
Multiple paragraphs Drag in the selection bar
An entire document Triple-click in the selection bar

To select an amount of text other than a word, sentence, or paragraph, position the I-beam
pointer on the first character of the text to be selected, hold down the left mouse button, drag the
I-beam pointer to the last character of the text to be selected, and then release the mouse button.
You can also select all text between the current insertion point and the I-beam pointer. To do this,
position the insertion point where you want the selection to begin, hold down the Shift key, lick
the I-beam pointer at the end of the selection, and then release the Shift key. To cancel a selection
using the mouse, lick anywhere in the document screen outside the selected text.

To select a specific amount of text using the keyboard, use the Extend Selection key, F8,
along with the arrow keys. When you press F8, the extend selection mode is turned on and the
EXE mode button on the Status bar displays in black letters.(You can also turn on the extend
selection mode by double-clicking the EXE mode button of the Status bar.)As you move the

insertion point through text, the text is selected. If you want to cancel the selection, press the Esc

« 10 -
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key, and then press any arrow key (or double-click the EXT mode button on the Status bar and

then press any arrow key). You can also select text with the keyboard and the mouse. After
clicking the beginning the text block, press the Shift key and click the end of the text block

simultaneously.

BN
terrific value.

To determine how much RAM you need, factor In the
demands of the applications you want to run simultaneously
as well as the operating system (256MB of RAM Is
recommended by Microsoft for optimal operation of Windows,
far instance). Then keep in mind that you'll inevitably add new
applications and create new files, and add accordingly

SDRAM, DDR SDRAM or RDRAM
Dell currently offers three different memary types SDRAM,
DDR SDRAM and RDRAM

SDRAM (synchronous dynamic RAM) Is the standard

memory offering in the PC industry. It is designed for

mainstream home and business applications, email, and basic
B als

§ 2.2 Selecting and Deleting Text

Practice:
1. Open Word Doc 02.
2. Save the document with Save As and name it Practice 1.
3. Make the following changes to the document:
a. Select the words and use no cabling at all and the period that follows located at the
end of the last sentence in the first paragraph and then press the Delete key.
b. Insert a period immediately following the word signal.
c. Delete the heading line containing the text QWERTY Keyboard and the blank line
below it using the Extend key, F8, by completing the following steps:

e 11 =
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1) Position the insertion point immediately before the Q in QWERTY.
2) Press F8 to turn on select.

3) Press the down arrow key twice.
4) Press the Delete key.
d. Delete the last sentence in the last paragraph using the mouse by completing the

following steps:
1) Position the I-beam pointer anywhere in the last paragraph.
2) Triple-click the left mouse button.
3) Press the Delete key.

4. Save the document with the same name by clicking the Save button on the Standard

toolbar or clicking File and then Save.

§ 2.3 Using Different Views

ey

Step 1 Using different Views
Normal view

Ayigw that shows text farmatting. snd 4.5

Norkmal view is convenient for most editing and formatting
tasks,

To switch to normal view, click Normal on the View menu, Or
click tha Normal View button  on the horizontal scroll bar.

Qutline view

A view that shows the headings of a document indented ta
represent their level in the document's structure, Outline view
makes it easy to mave guickly through a documenit, change the
relative impartance of headings, and rearrange large amounts
of test by moving headings. You can also use outine view to
develop or change the top-level structure of 3 master document
by adding, rearranging, and remaying subdocuments.

To switch to outline view, dick Outline on the View menu. Or
click the Outline View button  on the horizontal scroll bar.

Normal view

A view that shows text formatting and a simplified page layout. Normal view is convenient

-12-



